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This chapter provides information on how to use CiscoView. It is divided into the followi
sections:

• Understanding the CiscoView Main Window

• Understanding Configuration

• Starting CiscoView and Displaying a Device

• Changing CiscoView Operating Characteristics

• Finding Devices

• Using the Dashboard Monitor

• Using CiscoView Tables

• Using Online Help

Note For additional information on CiscoView, see the context-sensitive help system
This comprehensive help system provides procedures, overview material, and links 
related information.
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Understanding the CiscoView Main Window
When you first open CiscoView, a small window appears, as shown in Figure 3-1.

Figure 3-1 CiscoView Main Menu

Many of the menu items are grayed out because you have not opened a device. Onc
device is open, a larger window appears showing the front or rear panel of the devic
Figure 3-2 shows the main CiscoView window displaying a Cisco 4000 device.

Figure 3-2 CiscoView Main Window, Displaying a Cisco 4000 Device
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Title bar—provides the CiscoView application name and the name of the currently
connected device.

Menu bar—enables you to perform CiscoView tasks, including displaying configurati
and performance information for devices, cards, and ports; displaying different devic
representations; and controlling some of the operating characteristics of CiscoView.

Toolbar—provides a shortcut for entering important CiscoView commands such as P
Help, Configure, or Monitor, and for launching applications, when available, such as
Telnet.

System information—displays information about the type of device, the Cisco device
software that is running, and additional system information. For some devices, CPU u
displayed.

Device view—displays a graphical representation of the back or front panel of the dev
Click on this area to display information about different parts of the device. For exam
to display information regarding the configuration of an Ethernet port on a Cisco AS5
device rear panel, double-click the port or do the following:

• Select the port. From the Menu bar, selectConfigure>port....

• Click and hold down the right mouse button to display the port popup window. Se
Configure>Port.

• For more information on a particular device, press F1 with the mouse button positio
over the display for that device. All devices may not support the use of F1.

Status bar—provides a brief description of the currently selected device, interface, or p
and provides an ongoing operational status, including polling and error message
information. For port status details, refer to Table 3-1.

Legend—provides information about port status (see Table 3-1).

Table 3-1 CiscoView Port Status Legend

Color Indicates

Cyan or greenish blue Dormant or waiting for an external event, such as receiving
packets to transmit or dialing a remote site

Brown Administratively down
 Using CiscoView 3-3
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Popup menus—go to the configuration and monitor information for the device, a card,
port. For more information on popup menus, see “Starting CiscoView and Displaying
Device” later in this chapter.

Menus can vary, depending on the device you are using. If an option is grayed out, it is
applicable to that device. Table 3-2 and Table 3-3 describe menu items found in the
CiscoView File menu and the View menu.

Table 3-2 CiscoView File Menu Items

Red Operational failure

Yellow Minor alarm

Magenta Testing

Green Up

Item Explanation

Open Device Displays the back panel of a new device

Open Previous Reviews a list of devices that you have already displayed

Print Prints the physical view of the device

Print Setup Displays and allows you to change printer parameters

Exit Exits CiscoView

Table 3-3 CiscoView View Menu Items

Item Explanation

Refresh Refreshes the current display by making sure that all information is
current.

50% Toggles the size of the device display between 50 and 100 percen

Table 3-1 CiscoView Port Status Legend (Continued)

Color Indicates
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The Configure menu depends on the device you are using and what you have selec
the device to configure: the device itself, a card, or a port. For example, port configura
menu items might be Configure>basePort, or Configure>TTY_port. For more informa
on displaying a device, see “Starting CiscoView and Displaying a Device” later in this
chapter. Table 3-4 describes typical Configure menu items.

Table 3-4 CiscoView Configure Menu Items

The Monitor menu depends on the device you are using and what you have selected o
device to monitor: the device itself, a card, or a port. For more information on displayin
device, see “Starting CiscoView and Displaying a Device” later in this chapter. Table
describes the Monitor menu items.

Stack Displays the devices in sequence of their physical order. It is graye
out if the device does not support the stack feature.

Front View Displays the front panel of a device for selected devices only.

Rear Displays the real panel of the device.

Logical Displays the logical modem connections on a Cisco AS5200 only.

Item Explanation

Device Displays device configuration information. If nothing is selected,
the device configuration is displayed.

Card Displays card configuration information for a selected card. To
view the card information, select a specific card first, then select
Configure>Card.

Port Displays port configuration information for a selected port. To view
the port information, select a specific port first, then select
Configure>Port. The types of ports that can be selected are modem
port, port_tty, or port_con, depending on the type of device you are
using.

Table 3-3 CiscoView View Menu Items (Continued)

Item Explanation
 Using CiscoView 3-5
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Table 3-5 CiscoView Monitor Menu Items

The Options menu allows you to change the presentation and the operating characte
of CiscoView. For example, if you wanted to display the Toolbar or change the pollin
frequency, you do it through the Options menu. Table 3-6 describes the Options men
items.

Table 3-6 CiscoView Options Menu Items

Item Explanation

Device Displays the monitoring information for a selected device. The
monitoring information describes the various performance aspects
of a device, card, or port. The monitor window is a collection of
graphical displays presented as dials or stripcharts, known as a
dashboard. For more information on monitoring information, see
“Using the Dashboard Monitor.”

Card Displays the monitoring information for a selected card.

Port Displays the monitoring information for a selected port.

Item Explanation

Show Toolbar Displays or hides the toolbar to access shortcut commands.

Show Legend Displays or hides the legend.

Show System Information Displays or hides system information.

Properties Sets various operating characteristics, including polling frequency
the number of retries, the timeout interval, the Read and Write
community string, MIB labels displayed as descriptors or an alias,
and where to launch CiscoView: either in the same window or a
separate one.

Debug Displays troubleshooting information and should be used only with
Cisco support personnel. Writes the trace for device discovery and
status polling to the/tmp/.cvlog.

Debug SNMP Displays all the SNMP traffic in encoded form to and from the
device and should be used only with advice from Cisco support
personnel.
3-6 Overview for CiscoWorks Windows
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The Admin menu appears on specific devices that have administrative option feature
Refer to the online help for more information.

Understanding Configuration
Configuration is a process that establishes the characteristics of the devices and servi
the network and records this information in the appropriate files. Configuring a device
management means supplying information about the specific device. After the speci
aspects of the device are entered into the system, the system can identify the device
monitor its performance, and you can manage the device using CiscoView.

You configure devices through CiscoView. See the online help for details on configur
specific devices.

Starting CiscoView and Displaying a Device
There are several ways to display a CiscoView device, including

• Using CiscoWorks

• Using other network management platforms

• Using the command line

The CiscoView Open Device dialog box allows you to display a device in CiscoView or
change the currently displayed device. To display information, you need to know the R
Community Name and the Write Community Name. The community string is a Simp
Network Management Protocol (SNMP) security feature that requires a password to ac
SNMP features on a host, such as a Cisco router. Community strings used in CiscoV
must match the device strings and the strings for the network management platform
otherwise permission will be denied. To display the device, do the following:

Step 1 SelectFile>Open Device...

Step 2 Enter the name or IP address of the device that you want to view in the Host fi

Step 3 Enter the Read Community string in the Read Community field.

Step 4 Enter the Write Community string in the Write Community field.
 Using CiscoView 3-7
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Step 5 Click OK .

CiscoView displays a front or rear panel of the device. To display informati
change configurations, and change community string information at the
management window, you need to enter the Read/Write All password in th
Read Community and Write Community fields in this dialog box. If you ope
the device without a Write Community string, and need to change device
information, you can use theOption>Properties dialog box to reset the
community string information.

Note The File>Open Previouscommand displays a list of devices that have
been viewed previously. If you select a previously viewed device that has n
been opened during the current session, a dialog box appears in which you
specify the community strings. If the device has already been viewed during
current session, the community strings have been saved by CiscoView so 
device display appears immediately. Only device names and addresses ar
retained from session to session.

Understanding the Display
The display you see when you first enter CiscoView is of the front or rear panel of th
device. Click on various parts of the graphic to see what it contains.

After you have made a selection from the panel, selectConfigure or Monitor to configure
or monitor the device, card, or port.

You can also use the right mouse button to get to a popup menu that allows you to confi
or monitor a device, card, or port. For example, if you are using a Cisco AS5200 card
need port information, select a port on the display and click the right mouse button. T
following popup menu appears:

Select one of the options,Configure, Monitor , orReset.

Port
Configure...
Monitor...
Reset
3-8 Overview for CiscoWorks Windows
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Printing a Display
You can print the CiscoView Main window and specify certain printing options. To pri
the main window, selectFile>Print .

To print the main window, and specify printing options, do the following:

Step 1 SelectFile>Print Setup.

The CiscoView Print Setup window is displayed.

Step 2 In the Printer Name field, select a printer from the scrolling list, or enter the
name of a printer.

Step 3 In the Copies field, enter the number of copies you want to print.

Step 4 In the Orientation field, select the paper orientation for printing by clicking o
the radio button next to the appropriate orientation format: portrait or landsca

Step 5 In the Format field, select your printer format type by clicking on the radio
button next to the appropriate option: Ljet or PostScript. Ljet (LaserJet) prin
the CiscoView Main window in PCL. PostScript prints the window in
PostScript. For most low-end printers, use the Ljet option.

Step 6 Click OK  to close this window.

Step 7 SelectFile>Print  to print the window display.

Changing CiscoView Operating Characteristics
You can change some CiscoView operating characteristics, such as the polling frequ
or the number of retries, from within the CiscoView application. To change the opera
characteristics, do the following:

Step 1 SelectOptions>Properties.

The CiscoView Properties dialog box appears.

Step 2 Enter a value in the Polling Frequency field to change the polling frequency. T
default varies by device. A typical value is every 60 seconds. To disable poll
frequency, set the value to zero. If you set the polling frequency below
 Using CiscoView 3-9
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60 seconds for a number of devices, it might slow down your network. It is
advisable to use low polling frequencies in specific testing situations and cha
them back when done. Do not poll faster than every 5 seconds.

Step 3 Enter a new value in the Retries field to change the number of retries. The de
is 3. The retries value indicates how many times CiscoView retries an
unresponsive device. In busy networks, SNMP datagrams can get discarded
Retries value allows the application to continue operation during network
problems. A value of 3 is considered reasonable. You can increase the val
the network is slow.

Step 4 Enter a new value in the Timeout field to change the timeout interval. A timeo
is the amount of time it takes to reach a device. If it takes longer than the t
specified, the device is considered either unreachable or down. The interva
value is specified in seconds. The default is 3.

As a guideline, the timeout value should be set to twice the average end-to-
delay in your network. If you have a network with several slow links, you mig
need to set the timeout to a higher value. If you have only LAN links in you
network, a value of 2 seconds is reasonable to account for processing delay
timer accuracy.

In high traffic situations, you might experience timeouts. You should not redu
the polling frequency since this can cause a general error. Increase the tim
interval if you consistently experience timeouts.

Step 5 Click the radio button next to the MIB Label translation field to display MIB
descriptors instead of textual labels. Textual labels are the default. MIB
descriptors are actual variable names used to manage devices, for examp
locIfOutBitsSec and MIB textual labels are aliases of the MIB descriptor. T
MIB textual label for locIfOutBitsSec is Output BPS.

Step 6 Enter the string in the appropriate field to enter the Read or Write Commun
string. This option allows you to enter the write community string for a devi
after you display the device.

This is useful, for example, if you want to make changes to a device or por
setting but did not specify the write community string when you first opened t
device display. You can enter the write community string in the Write
Community field without exiting and reopening the dialog box.
3-10 Overview for CiscoWorks Windows



Finding Devices

e

se

the

vices
ered

es
data

ce
to

.

Step 7 Select the window from which you want to launch CiscoView, from the sam
window or from a separate window. The default is Separate.

Note Multiple instances of CiscoView can slow down your machine becau
higher RAM requirements are needed for this use.

This option allows you to keep the desktop from being cluttered by reusing
existing CiscoView window to display devices.

Step 8 Click OK  to have the changes you made take effect.

Finding Devices
Sometimes finding a device on a large network can pose a problem, but you can find de
in CiscoView easily once you understand how the information is organized. Topics cov
are:

• Organizing Management Information

• Categorizing Information

Organizing Management Information
CiscoView displays two primary types of information. Configuration information includ
data such as information about a device chassis. Performance information includes 
such as the number of Ethernet errors during a given period.

Configuration information is displayed in CiscoView Configuration windows. Performan
information is displayed in CiscoView Monitor windows, which are sometimes referred
as dashboards.

Configuration and performance information is displayed for devices, cards, and ports
 Using CiscoView 3-11
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Categorizing Information
CiscoView displays different categories of information for each device, card, and port
see the categories of information that can be displayed for each component type, look
CATEGORY popup menu on the Configuration or Monitor windows. To display a
particular type of information, select the category type.

Displaying Configuration Information
CiscoView displays configuration information through the Configuration menu on the
CiscoView main window or by selectingConfigure from a component popup menu.
CiscoView displays configuration information in the Configuration window that includ
either a list of fields for a single port or a table that includes fields for multiple ports.

Displaying Performance Information
CiscoView displays performance information through the Monitor menu on the main
window or by selectingMonitor from a component popup menu. Performance informatio
is displayed in a dashboard made up of a collection of small graphical displays in on
window. For more information on the dashboard monitor, see “Using the Dashboard
Monitor” section.

Using the Dashboard Monitor
The dashboard monitor displays various types of network performance information, 
as poll utilization errors. The display depends on the type of type of device and wheth
is a device or a port. A typical dashboard monitor consists of dials or stripcharts, as sh
in Figure 3-3.
3-12 Overview for CiscoWorks Windows
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Figure 3-3 Dashboard Monitor

Each display represents information provided by a MIB variable, with the common
meaning indicated above the display.

Using the Grapher Tool
Within the dashboard monitor is a grapher tool that you can use to depict performan
graph form. To start the grapher tool for the network management platform, you sele
graphical display in the dashboard and click the Grapher button. You can use all of t
features of the grapher tool when you are troubleshooting performance problems. Th
network management platform grapher tool cannot support the graphing of multiple 
variables in one data set. If the selected graphical display is composed of such formula
following error message appears:

Sorry, can’t graph formulas.
 Using CiscoView 3-13
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Using CiscoView Tables
For some devices, CiscoView allows you to select multiple ports. You can display
configuration or performance information for multiple ports or port groups in a single
window. The entries that can be modified are displayed in pink on a color monitor.
Figure 3-4 shows the table for three of the ports for a Cisco AS5200 card.

Figure 3-4 CiscoView Tables

To create a CiscoView table:

Step 1 Select multiple ports by clicking on them as you hold down the Shift key.

Step 2 Click Configure or Monitor .

A CiscoView Table appears, displaying information about all the selected po

You can add, delete, or modify table entries. Table 3-7 describes how to edit CiscoVi
Tables.h

Table 3-7 Editing CiscoView Tables

Change Action

Add an entry SelectCreate.

Modify an entry 1 Select the table column entry that you want to modify.

2 View the possible values, if available, by displaying the popup
menu next to the entry.

3 Select or enter the new value in the table column.

4 Click Modify .

5 Click OK .
3-14 Overview for CiscoWorks Windows
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Using Online Help
Context-sensitive online help provides you with step-by-step instructions on how to u
CiscoWorks Windows applications. The help system also provides a glossary and key
search capability. The following table provides a quick guideline to access help from
number of vantage points:

Because CiscoView device packages are independent, the help system for each pac
might vary slightly.

Note Report any help or documentation bugs to cs-ciscoworks@cisco.com or
bug-doc@cisco.com.

Remove an entry 1 Select any column in the table row that you want to delete.

2 Click Delete.

3 Click OK .

For Information about Do This

The help system for specific products SelectHelp>Contents

How to use the help system SelectHelp>Using Help

How to use CiscoView features SelectHelp>Using CiscoView

Current CiscoView versions SelectHelp>About CiscoView

The current device package version SelectHelp>About CiscoView

How to view configuration and
performance, dashboard windows, and
field descriptions

Click Help in the dialog box

How to change a component value ClickHelp with the cursor over the field

How to use help view SelectHelp>On Help

Table 3-7 Editing CiscoView Tables (Continued)

Change Action
 Using CiscoView 3-15
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Jumps and Popup Windows
Two key concepts in using the help system are jumps and popup windows. Click on 
highlighted underlined topic to jump to a help window specific to that topic. When yo
jump to another topic, you need to clickBack on the Menu bar to go back to the previous
help topic. Click on a dotted underlined term to open a popup help window, which defi
that term. When you go to a popup window, pressReturn to return to your previous help
topic.

Help Topics Window
You open the Help Topics window by selectingHelp>Contentsor by clickingHelp Topics
in an open CiscoView help window. The Help Topics window has three functional tab

• Contents tab—links to CiscoView device and application help topics and subtopic

• Index tab—searches for keywords in the help system.

• Find tab—allows you to search the help system, and indexes every help word.

For information on how to use this tab, selectHelp>Using Help from the CiscoView
menu bar.

Help Window Menu and Button Bars
Each help window has a menu bar and a button bar. The menu bar provides standar
functions for printing help topics, copying and pasting text from help topics, making onl
notes about particular help topics, and placing bookmarks.

The button bar contains the following buttons:

• Contents—Opens the current help table of contents. Help topics are highlighted a
underlined. Select a help topic to open a help window specific to the underlined to
Some topics open popup windows that contain a list of subtopics. Select a help sub
to open a help window specific to the underlined subtopic.

• Back—Moves you back sequentially to previously opened help windows.
3-16 Overview for CiscoWorks Windows
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• Print—Prints current help topic window.

• Browse—Allows you to browse through sets of related help screens, providing qu
access to overviews of particular help topics.

Overview and See Also Links
Many help windows have Overview and See Also links in the help window topics. You c
select the Overview link to obtain background information for the procedure describe
the current help window. Select the See Also link to view a list of related topics and g
directly to those topics from the current help window.

Exit Help
SelectFile>Exit  from Help window menu bar to exit Help.
 Using CiscoView 3-17
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